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Welcome

Avenza welcomes you to mapmaking in the 21st century!

Combined with Adobe Illustrator, MAPublisher has revolutionized the art of mapmaking by allowing spatial data 
files to be used to create maps inside a vector graphics program. MAPublisher allows all your cartographic tasks to 
be performed where they should be done; in a powerful graphics environment.

MAPublisher LabelPro™ revolutionizes the way users can label map data, including using symbols as labels, conflict 
resolution, and highly configurable rule-based labelling options. The MAP LabelPro engine uses map data attributes 
for labelling with styles, rules and controls configured through an intuitive, easy-to-use Graphical User Interface.

This tutorial assumes that the user is familiar with Adobe Illustrator CS3 or CS4, and has at least a basic understanding 
of MAPublisher functions. This tutorial should be used in conjunction with the MAPublisher 8 User Guide , 
MAPublisher 8 Tutorial Guide and Quick Start Guide for an understanding of all the other MAPublisher tools. 

By following this tutorial, you will learn how to setup and use the MAP LabelPro labelling engine to label your 
map created in MAPublisher. Working on a provided map, users learn to create rules and styles for labelling in an 
automated and efficient way. 

Not all MAPublisher tools are explained in this document. Exercises related to each individual tool are covered in the 
full MAPublisher 8 Tutorial Guide.

MAP LabelPro Tutorial Data

This tutorial will use Adobe Illustrator files and MAP LabelPro rules supplied on your MAPublisher 8 CD or in the 
electronic download. Alternatively, if you have installed the software, you can find the MAP LabelPro Tutorial data in 
the following location on your hard drive:

Windows XP
C:\Documents and Settings\All Users\Shared Documents\Avenza\MAPublisher 8\MAP LabelPro Tutorial & Data\Data

Windows Vista
C:\Users\Public\Public Documents\Avenza\MAPublisher 8\MAP LabelPro Tutorial & Data\Data

NOTE: This data may be accessed through shortcuts available in the Windows start menu 

Mac OS X
/Applications/Avenza/MAPublisher 8/MAPublisher Tutorials/MAP LabelPro Tutorial & Data/Data

You are encouraged to experiment with your own data to gain additional experience with MAPublisher tools and 
functions.
 
Tutorial data courtesy of City and County of San Francisco (San Francisco Enterprise GIS program SFGIS).
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0  Preliminaries

0.1  PURPOSE

The purpose of this exercise is to use MAP LabelPro to create labels for a simple map of downtown San Francisco, 
California, USA. For this exercise, Avenza has prepared the necessary map file created with MAPublisher 8 and Adobe 
Illustrator, based on City and County of San Francisco GIS data (San Francisco Enterprise GIS program SFGIS). The map 
contains all the different type of features (point, line and area) for labelling and/or obstacle purpose. 

In this exercise, you will start by preparing the file and examining the data to familiarize yourself with the 
prerequisites to using MAP LabelPro. Then, the labelling will be done in two steps: a main labelling session (labelling 
public schools, streets, interstates, highways and land areas in one run) and a secondary session (labelling parks 
only, using the other labels as obstacles). Although the presented settings are valid only for the map data they are 
based on, the principles are applicable for your own designs.

0.2  KNOW YOUR DATA

The MAP LabelPro Tutorial data folder contains a ready-to-use Adobe Illustrator template file containing a map of 
downtown San Francisco (MAPLabelPro_Tutorial.ait). Here is a description of the layers present in the file and how 
they will be used during the labelling process.

0.2.1  San Francisco map description

Layer name Type Description Labelling Attribute
(label source layers)

Obstacle?
session1  | session2

Text layers

LAND_labels Text Land labels - No

SCHOOL_labels Text School labels - - Yes

STREET_labels Text Street labels - - Yes

PARK_labels Text Park labels - - -

HIGHWAY_INTERSTATE_labels Text Labels for highways and interstates - - Yes

SUPPRESSED_labels Text Labels that couldn't be placed based 
on the specified rules.

- - No

MAP_TITLE Text Map title (San Francisco) - Yes No

MAP Layers

Public_Schools_point Point Public school locations SCHOOL_NAME Yes Yes

Post_Offices_point Point Post office locations - Yes Yes

Highways_line Line Highway roads HIGHWAY_NUMBER Yes Yes

Interstates_line Line Interstate roads INTERSTATE_NUMBER Yes Yes

Ramp_line Line Ramps to highways - No No

Streets_line Line San Francisco street network STREETNAME No No

Land_area Area Land areas AREA_NAME No No

Parks_area Area Park areas PARK_NAME Yes No
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Layer name Type Description Labelling Attribute
(label source layers)

Obstacle?
session1  | session2

Other Layers

Scale_Bar Legend Scale bar - -

background Blue background to represent 
the sea

- -

All MAP Layers were imported from City and County of San Francisco GIS data (San Francisco Enterprise GIS program 
SFGIS) in ESRI shapefile format and cropped to the area of interest. The map design (symbols and line styles) was 
created by Avenza.

0.2.2  Styles and Rules
MAPublisher has been installed with predefined styles and rules to use for the MAP LabelPro settings in this tutorial. 
These configuration files are saved to one of three folders depending on the data type layer,  Area,  Line or	  

 Point, they are associated with. 

Layer Name Type Style
\LabelPro\Styles

Rule
\LabelPro\Rules

Public_Schools_point Points School_Label_Style School_Label_Rule

Interstates_line Lines Interstate_Label_Style Interstate_Label_Rule

Highways_line Lines Highway_Label_Style Highway_Label_Rule

Streets_line Lines Street_Label Style Street_Label Rule

Parks_area Areas - -

Land_area Areas Land_Label_Style Land_Label_Rule

The style and rules for the Parks_area layer will be created during the second labelling session of this exercise.

NOTE:	  The default location of the Rules and Styles folders is:

Windows XP: C:\Documents and Settings\All Users\Application Data\Avenza\MAPublisher 8\LabelPro\Rules
Windows Vista: C:\ProgramData\Avenza\MAPublisher 8\LabelPro\Rules
Mac OS X: Applications/Avenza/MAPublisher 8/MAPublisher Plug-In/LabelPro/Rules

	 The MAP LabelPro tutorial data folder also contains a backup for these rules and styles

0.2.3  Important note for MAPublisher LabelPro evaluation users
The evaluation version of MAPublisher LabelPro scrambles the text of placed labels but preserves the case, spacing 
and punctuation, so that the results give a sense of how actual labels would be placed. Therefore, evaluation users 
will experience a different result with the MAP LabelPro settings of this tutorial than the licensed users. Throughout 
this document, both results will be shown and differences explained.

NOTE:	In evaluation mode, the scrambling process noticeably slows the speed of labelling.
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1  Getting Started

1.1  OPEN TUTORIAL DOCUMENT

1.	 In the Adobe Illustrator main menu, click File> Open and select the template file MAPLabelPro_Tutorial.ait located in 
\MAPublisher 8\MAPLabelPro Tutorial&Data\Data. 

An artboard containing a map of San Francisco opens. All the data information to be used for labelling is present, 
except for the text labels. Please see the table in the Preliminaries chapter for the description of the layers.

2.	 Because the file was opened from a template, a new untitled document was created. Choose from the Adobe 
Illustrator main menu File > Save As to save the file as SanFrancisco.ai. 

NOTE:	Customize the Adobe Illustrator workspace to make it easier to access panels. It may look different than 
the image above. Read Customizing the workspace in the Adobe Illustrator help guide for more information. 
Review also MAPublisher Preferences in the MAPublisher User Guide.

1.2  EXAMINE MAP ATTRIBUTES AVAILABLE FOR LABELLING

For each MAP Layer to be labelled, MAP LabelPro extracts the label data from its attribute table. Therefore, it is good 
practice and often required to examine and eventually edit the attribute information in the MAP Attributes panel. 
Edits can include: creating a new column to enter attribute values, joining tables to import additional attribute 
information from an external file, correcting spelling, changing the case of text and more.

For this exercise, all attributes are ready to use for labelling. Follow the steps here to examine them and familiarize 
yourself with the data.
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NOTE:	For more information on the MAP Attributes panel, please refer to the MAPublisher 8 User Guide, chapter 5. 
For more exercises using this tool, please go through the MAPublisher Quick Start Guide and MAPublisher 
Tutorial Guide.

1.	 In the Adobe Illustrator Layers panel, click the target button  next to the Public_Schools_point layer to select all 
artwork on the layer.

2.	 Open the MAP Attributes panel (from the Adobe Illustrator main menu, choose Window > MAPublisher> MAP 
Attributes or click the Map Attributes button on the MAPublisher toolbar. ).

The Public_Schools_point layer contains four visible attribute columns: OBJECTID, FACILITY_I, DEPTNAME and 
SCHOOL_NAME. The SCHOOL_NAME attribute column will be used for labelling the school points.

 

3.	 Select all artwork on the Interstates_Line layer and view the attributes in the MAP Attributes panel.

The INTERSTATE_NUMBER attribute column will be used for labelling these roads.

NOTE:	Notice that the INTERSTATE_NUMBER attribute is of type integer . All types of attributes may be used for 
labelling with MAP LabelPro.

4.	 Select all on the Highways_line layer and view the attributes in the MAP Attributes panel. HIGHWAY_NUMBER 
will be used for labelling.

5.	 Select all on the Streets_line layer and view the attributes in the MAP Attributes panel. STREETNAME will be used 
for labelling.

6.	 Select all on the Parks_area layer and view the attributes in the MAP Attributes panel. PARK_NAME will be used 
for labelling.

7.	 Select all on the Land_area layer and view the attributes in the MAP Attributes panel. AREA_NAME will be used 
for labelling.

8.	 The MAP Attributes table may be closed for the rest of the exercise.

Knowing this information, we are ready to use the MAP LabelPro function to generate map labels for the San 
Francisco downtown map.
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2  Main Labelling Session

In this first main labelling session, multiple layers will be labelled in a single run of the MAP LabelPro function. The 
objectives are to:

•	 Add labels for school as a first priority (source layer Public_Schools_point).
•	 Label the interstate roads with interstate shield symbols containing the interstate number (source layer 

Interstates_line).
•	 Label the highway roads with highway shield symbols containing the highway number (source layer 

Highways_line).
•	 Add street names (source layer Streets_line).
•	 Add names for land areas, written in the sea to make the map more readable (source layer Land_area).
•	 Make sure that the school and road names do not overlap with the post office and school symbols and park 

area, and do not cross highways and interstates line (obstacle layers: Post_Offices_point, Public_Schools_
point, Parks_area, Interstates_line and Highways_line).

To start the MAP LabelPro Editor, click the MAP LabelPro button on the MAPublisher Toolbar or choose the 
menu Object > Filters > MAP LabelPro > MAP LabelPro... (Adobe Illustrator CS4) or Filter > MAP LabelPro > MAP 
LabelPro... (Adobe Illustrator CS3).

MAP LabelPro

The MAP LabelPro dialog box opens.

The workflow steps are to first setup the layers to be used as sources for labelling and/or as an obstacle, to specify 
the labelling extents, and finally label destination layers, styles and rules will be set.

NOTE:	All layers have to be configured before labelling with MAP LabelPro (Save & Label button). If the dialog box 
is closed before all configurations are done, make sure to click the Save button to save the configuration. If 
labelling has been executed and an Undo action is used afterwards, the configurations in MAP LabelPro will 
revert to the configuration before the labelling was executed. To ensure that your configuration is saved, 
click the Save button.
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2.1  LAYERS AND OBSTACLES SETUP

1.	 In the MAP LabelPro Editor, click the Setup Layers button to select the source and obstacle layers.
2.	 In the Setup Layers dialog box, click the Label check box of the following layers to enable them as source layers:

•	 Highways_line
•	 Interstates_line
•	 Land_area
•	 Public_Schools_point
•	 Streets_line

3.	 Then, click the Obstacle check box of the following layers to enable them as obstacle layers:
•	 Highways_line
•	 Interstates_line
•	 MAP_TITLE
•	 Parks_area
•	 Post_Offices_point
•	 Public_Schools_point

4.	 Make sure that the settings match the image above and click OK. 

The MAP LabelPro dialog box gets updated according to the layers settings. Selected layers for labelling are added 
to the Source list and selected layers for obstacles are added in the Obstacle layers list. 
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2.2  LABELLING EXTENTS SETUP

The configuration described in this exercise will limit the creation of labels to the extent of the selected source 
layers for labelling, with a margin of 0.2 inches on each side.

1.	 Click the Advanced button in the MAP LabelPro dialog box.
2.	 In the Label Placement Area frame, select the option Extents of labeled source layers.
3.	 Click the Label Margins check box to enable its settings. Set the Top, Left, Right and Bottom drop-down lists to 0.2 in.
4.	 In the Obstacles frame, do not select the option Paths without stroke are not considered obstacles.

NOTE:	If the option Paths without stroke are not considered obstacles is enabled, areas that have no stroke will not be 
used as an obstacle in the labelling process, allowing generated labels to overlap with them.

5.	 Make sure that the settings match the image above and click OK.

The label styles and rules of each source layer are now ready to be set.

2.3  POINT LAYER LABEL SETTINGS

1.	 In the MAP LabelPro dialog box, click the Public_Schools_point layer name in the Source column to highlight the row.

By default, the attribute to use as a label is set to FACILITY_I, the first string attribute column of the Public_Schools_
point layer. It needs to be changed to SCHOOL_NAME.

2.	 Click FACILITY_I in the Attribute column. This enables a drop-down list with all the attributes of the 		
Public_Schools_point layer. Click SCHOOL_NAME in the list. 

NOTE:	You may have to increase the width of the Attribute column to see the full name of attributes.

3.	 In the Destination column, change the destination text layer selected by default (HIGHWAY_INTERSTATE_labels) to 
SCHOOL_labels.

4.	 Leave the Priority column set to 1. The Public_Schools_point will be labelled as a first priority, all the others will be 
of second priority.
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5.	 In the Style column, click [Default] and select School_Label_Style in the drop-down list. This style has been 
predefined by Avenza, click the Edit button  to open the Style dialog box and examine these settings.

NOTE: 	The second labelling session will show how to create a new style from scratch.

6.	 In the Style dialog box, click OK.
7.	 In the MAP LabelPro dialog box, under the Rules column, click [Default] and select School_Label_Rule in the 

drop-down list. This rule has been predefined by Avenza, click the Edit button  to open the Point Rules 
dialog box and examine these settings.
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These point settings will force the labels to be placed below the symbols:
•	When possible, the text will be placed lower-middle to the symbol. 
•	If this is not possible due to space constrictions, text will be placed to the lower-right, and then to the lower-left.
•	If none of the options can be applied, the text will be placed on the suppression layer (or ignored if no 

suppression layer was specified).
Text stacking and font reduction have also been enabled to add flexibility to the placement rules.

NOTE: 	More information on the available labelling options can be found in the MAPublisher User Guide, chapter 18.

8.	 Click OK in the Point Rules dialog box to close the window.
9.	 In the Suppression Layer column, click the text [Ignored] and select SUPPRESSED_labels in the drop-down list. 

Labels that can not be placed using MAP LabelPro will be copied to this layer.

NOTE:	You might have to scroll to the right of the MAP LabelPro dialog box to see the Suppression Layer column.

This finalizes the configuration for the labelling of the Public_Schools_point layer. Do not close the MAP LabelPro 
dialog box as the configuration of the roads and land layers still have to be done.

2.4  LINE LAYERS LABEL SETTINGS

This section covers the labelling configuration for the source layers Highways_line, Interstates_line and Streets_line. 
Highways and interstates will be labelled using highway and interstate symbol shields—notice that these layers 
contain double-lines for each road (divided highways). 

2.4.1  Label lines with symbols
1.	 In the MAP LabelPro dialog box, click the Highways_line layer name in the Source column to highlight the row.
2.	 Click STREETNAME in the Attribute column, to enable the attribute drop-down list. Select HIGHWAY_NUMBER in 

the list. 
3.	 In the Destination column, keep the destination text layer selected by default (HIGHWAY_INTERSTATE_labels).
4.	 Set the Priority column to 2. 
5.	 In the Style column, click [Default] and select Highway_Label_Style in the drop-down list. This style has been 

predefined by Avenza, click the Edit button  to open the Style dialog box and examine these settings.

In addition to the regular font settings, line labels can also be labelled with symbols. In this case, the Label with symbol 
option is enabled. Symbol files (*.lsf ) contain a series of symbols. In the example above, the United States Interstate 
symbol is selected from the generic_shields.lsf symbol file. The symbol size is set to 18.00 pt (different from the font 
size). The font color is set to white to be readable on the blue symbol.
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6.	 In the Style dialog box, click OK.
7.	 In the MAP LabelPro dialog box, in the Rules column, click [Default] and select Highway_Label_Rule in the drop-

down list. This rule has been predefined by Avenza, click the Edit button  to open the Line Rules dialog box 
and examine these settings.

With these settings, the highway labels (and shields) will be placed in the middle of each line length and on the 
centerline, with an eventual font reduction if necessary. The Divided Highways option recognizes lines that share the 
same name (as specified by the selected attribute) and that are parallel; in such cases it places only one symbol. This 
explains also why the Allow labels to cross lines option needs to be enabled in this case, because the double highway 
lines are very close to each other the labels will have to cross the lines. More information on the available line 
labelling rules can be found in the MAPublisher User Guide, chapter 18.

NOTE:	Evaluation users will see a different result than a licensed user. Because of the text scrambling, the divided 
highways cannot be recognized. Here is an example with the interstates:

Result with license:		  Result with evaluation:

		   

8.	 Click OK in the Line Rules dialog box to close the window.
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9.	 Back in the MAP LabelPro dialog box, In the Suppression Layer column, click the text [Ignored] and select 
SUPPRESSED_labels in the drop-down list. 

The settings for the Highways_line layer are completed; continuing with the settings for the Interstates_line layer.

10.	 Click the Interstates_line layer name in the Source column to highlight the row.
11.	 Click STREETNAME in the Attribute column, to enable the attribute drop-down list. Select INTERSTATE_NUMBER 

in the list. 
12.	 In the Destination column, keep the destination text layer selected by default (HIGHWAY_INTERSTATE_labels).
13.	 Set the Priority column to 2. 
14.	 In the Style column, click [Default] and select Interstate_Label_Style in the drop-down list. This style has been 

predefined by Avenza, click the Edit button  to open the Style dialog box and examine these settings.

The United States Route symbol is selected from the generic_shields.lsf symbol file. The symbol size is set to 18.00 pt 
(different from the font size).

15.	 In the Style dialog box, click OK.
16.	 In the MAP LabelPro dialog box, in the Rules column, click [Default] and select Interstate_Label_Rule in the 

drop-down list. This rule has been predefined by Avenza, click the Edit button  to open the Line Rules dialog 
box and examine these settings.

The labelling rules for the interstates are the same as for the highways. The previous note applies for evaluation users.

17.	 Click OK in the Line Rules dialog box to close the window.
18.	 In the Suppression Layer column, click the text [Ignored] and select SUPPRESSED_labels in the drop-down list. 

Labels that will not be able to be placed using the MAP LabelPro will be copied to this layer.

The label settings for the interstate roads are now complete, continuing on with the street labels.

2.4.2  Label lines with text only
1.	 Back in the MAP LabelPro dialog box, click the Streets_line layer name in the Source column to highlight the row.
2.	 In the Attribute column, keep STREETNAME as selected attribute for labelling.
3.	 In the Destination column, change the destination text layer selected by default (HIGHWAY_INTERSTATE_labels) to 

STREET_labels.
4.	 Set the Priority column to 2. 
5.	 In the Style column, click [Default] and select Street_Label_Style in the drop-down list. This style has been 

predefined by Avenza, click the Edit button  to open the Style dialog box and examine these settings.
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Notice that this time the Label with symbol option is disabled.
6.	 In the Style dialog box, click OK.
7.	 In the MAP LabelPro dialog box, in the Rules column, click [Default] and select Street_Label_Rule in the drop-down 

list. This rule has been predefined by Avenza, click the Edit button  to open the Line Rules dialog box and 
examine these settings.

Like highway and interstate labels, street labels will be placed in the middle of each line length and on the 
centerline, with an eventual font reduction if necessary. The ability to overhang is also enabled (Allow overhang). 

The street lines in this file are not joined, i.e. each street is made of many line  segments that all share the same 
STREETNAME attribute. To avoid repeating the name of connecting lines, the option Label joined feature has been 
enabled. MAP LabelPro will recognize that connecting lines sharing a same name need to be labelled only once.
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NOTE:	  Evaluation users will see a different result than a licensed user. Because of the text scrambling, the names 
are not recognized as being the same, therefore a label will get created for each line segment rather than 
one per street.

Result with license:				    Result with evaluation:

		   

8.	 Click OK in the Line Rules dialog box to close the window.
9.	 In the MAP LabelPro dialog box, in the Suppression Layer column, click the text [Ignored] and select 

SUPPRESSED_labels in the drop-down list. 

This completes the label settings for all line layers. Do not close the MAP LabelPro dialog box as the configuration 
of the Land_area layer still has to be done.

2.5  AREA LAYER LABEL SETTINGS

This section covers the labelling configuration for the source layers Land_area. The goal is to add large labels for the 
land areas of the map (downtown area, Treasure and Alcatraz Islands). 

1.	 In the MAP LabelPro dialog box, click the Land_area layer name in the Source column to highlight the row.
2.	 In the Attribute column, keep AREA_NAME as the selected attribute for labelling.
3.	 In the Destination column, change the destination text layer selected by default (HIGHWAY_INTERSTATE_labels) to 

LAND_labels.
4.	 Set the Priority column to 2. 
5.	 In the Style column, click [Default] and select Land_Label_Style in the drop-down list. This style has been 

predefined by Avenza, click the Edit button  to open the Style dialog box and examine these settings.

NOTE:	The sample text is truncated because the font size is set to 70 pt
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6.	 In the Style dialog box, click OK.
7.	 In the MAP LabelPro dialog box, under the Rules column, click [Default] and select Land_Label_Rule in the 

drop-down list. This rule has been predefined by Avenza, click the Edit button  to open the Area Rules dialog 
box and examine these settings.

The main requirement for labels created from the land_area layer is that labels are placed in the water area. 
Therefore, the option Allow outside is the only placement option enabled. Stacking and font reduction option are also 
enabled to give more flexibility to the rule. More information on the available area labelling rules can be found in 
the MAPublisher User Guide, chapter 18.

NOTE:	The second labelling session will explain the creation of area rules from scratch for the Parks_area layer.

8.	 Click OK in the Area Rules dialog box to close the window.
9.	 In the MAP LabelPro dialog box, in the Suppression Layer column, click the text [Ignored] and select 		

SUPPRESSED_labels in the drop-down list. 

All layers have been now configured for the first main labelling session.
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2.6  EXECUTE LABELLING WITH MAP LABELPRO

1.	 Make sure that all the layers have been configured to match the image below and click the Save & Label button.

NOTE:	For this session, the other labelling options will be kept as default:

•	 Source Art: Option to label all the source layers or label only the selected art on each source layer. In the 
example above, all objects will be labelled exactly as found in the source attributes.

•	 Label Case: Option to change the case of all the labels at once—to upper or lower case. In this exercise, the 
option is kept as Exactly as found in source attribute.

•	 Statistics: Option displays a report on placed and non-placed objects. It will be used in the Additional 
Labelling Session. For this example, the option is set to None.

2.	 (Evaluation users only) Click OK in the MAPublisher warning message.

3.	 Wait for the process to end to visualize the results (see next page).

NOTE:	Make the layer SUPPRESSED_labels visible to show labels that couldn't be placed with the specified rules.

4.	 Save the file and leave it open to continue on with the second labelling session.
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Result with  full license:

 	

Result with evaluation license:

	

NOTE:	The evaluation users will observe many more labels being placed on the map. The Label joined feature option 
in the street label rules fails to recognize similar street names due to the text scrambling. Similarly, highway 
and interstate roads are getting two shields with different numbers.
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3  Additional Labelling Session

In this second labelling session, continuing with the same file, only the parks will be labelled in a single run of the 
MAP LabelPro function. The objectives are to:

•	 Create a new area label style for park labels.
•	 Create a new area label rule for park labels.
•	 Make sure that the park labels do not overlap with the other labels and with the post office and school 

symbols, and do not cross highway and interstate lines.

To start MAP LabelPro, click the MAP LabelPro button on the MAPublisher Toolbar or choose the menu 	
Object > Filters > MAP LabelPro > MAP LabelPro... (Adobe Illustrator CS4) or Filter > MAP LabelPro > MAP LabelPro... 
(Adobe Illustrator CS3).

The settings from the previous labelling session are remembered. For the new session, the layer setup has to be 
changed to match the new objective of this exercise. However, the label extents remain the same as before.

3.1  LAYERS AND OBSTACLES SETUP

1.	 In the MAP LabelPro Editor, click the Setup Layers button to start setting up the source and obstacle layers.
2.	 In the Setup Layers dialog box, click the very top Label check box (at the level of the San Francisco Downtown MAP 

View). The Label check boxes of each layer are enabled.
3.	 Click again the very top Label check box. This time, all the Label check boxes are cleared
4.	 Click the Label check box of the Parks_area layer only.
5.	 Then, make sure that only the following layers are set as Obstacle (you may need to uncheck MAP_Title and 

Parks_area):
•	 Highways_line
•	 HIGHWAY_INTERSTATE_labels
•	 Interstates_line
•	 Post_Office_point
•	 Public_School_point
•	 SCHOOL_labels
•	 STREET_labels

6.	 Make sure that the settings match the image above and click OK. 
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The MAP LabelPro dialog box is updated with the new selected layer setup.

3.2  ADDITIONAL AREA LAYER LABEL SETTINGS

This section covers the labelling configuration for the source layer Parks_area. The goal is to add labels for the parks on 
the map, allowing the use of leader lines and font reduction. In this exercise, style and rules are created from scratch.

1.	 In the MAP LabelPro dialog box, click the Parks_area layer name in the Source column to highlight the row.
2.	 Click LAND_ID in the Attribute column to enable the attribute drop-down list. Click PARK_NAME in the list.
3.	 In the Destination column, change the destination text layer selected by default (HIGHWAY_INTERSTATE_labels) to 

PARK_labels.
4.	 Keep the Priority column set to 1. When labelling a single layer, the priority is irrelevant.
5.	 In the Style column, click [Default] and then the Edit button  to open the Style dialog box. 
6.	 Make sure that Arial is selected in the Family drop-down list.
7.	 Make sure that Regular is selected in the Style drop-down list.
8.	 In the Size drop-down list, set the font size to 7.00 pt
9.	 Click the  button in the Color settings.
10.	 In the Setup color dialog box, pick a dark green color (e.g. R=0, G=85, B=0).
11.	 Click OK to accept the color and return to the Style dialog box.

NOTE:	The Select Color dialog box may look different depending on the operating 
system in use.

12.	 Make sure that the Style dialog box is setup as below and click Save As. 
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13.	 In the Save As dialog box, type Park_Label_Style in the Name field and click Save.

14.	 In the Style dialog box, click OK to close it.

In the MAP LabelPro dialog box, the Style column now displays the text Park_Label_Style. The style is saved in the 
directory specified in the MAPublisher Preferences (see exercise 1.2).

15.	 In the MAP LabelPro dialog box, under the Rules column, click [Default] and then the Edit button  to open the 
Area Rules dialog box.

16.	 In the Area Rules dialog box, in the Placement frame, enable only the two options: Allow horizontal inside and Allow 
extending beyond boundary.

17.	 Enable the option Allow use of leader line by clicking the check box. Keep the default parameters: 
•	 Allowed Line Crosses: 3
•	 Leader Width: 1 pt
•	 Arrow Style: Style #1

18.	 Make sure that the option Allow stacking is enabled and select Up to 4 in the drop-down list.
19.	 Disable the option Allow labels to cross lines.
20.	 Make sure that the option Allow font reduction is enabled and set to 4 steps. 
21.	 Make sure that the settings are matching the image below and click Save As.



24 MAPublisher 8 MAP LabelPro Tutorial
3  Additional Labelling Session

22.	 In the Save As dialog box, type Park_Label_Rule in the Name field and click Save.

23.	 In the Area Rules dialog box, click OK to close it.
24.	 In the Suppression Layer column, click the text [Ignored] and select SUPPRESSED_labels in the drop-down list. 

In the MAP LabelPro dialog box, the Rules column now displays the text Park_Label_Rule. The rule is saved in the 
directory specified in the MAPublisher Preferences (see exercise 1.2).

3.3  EXECUTE LABELLING WITH MAP LABELPRO

1.	 In the MAP LabelPro dialog box, in the Options frame, set the Statistics drop-down list to Show All.
2.	 Make sure that all the layers have been configured as below and click the Save & Label button

A MAP LabelPro message displays the statistics of the label placement (results might vary for evaluation users).

 			 
Statistics with full license				    Statistic with evaluation license

3.	 Click Close in the MAP LabelPro Messages.
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Result with  full license:

Result with evaluation license:

Congratulations, you have completed the MAPublisher 8 MAP LabelPro tutorial. For more in-depth information on 
MAPublisher tools and features, please take a look at the MAPublisher 8 User Guide , MAPublisher 8 Tutorial Guide and 
Quick Start Guide. These documents are installed with MAPublisher 8 or can be downloaded from http://www.avenza.
com/support.documentation.html
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